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Copyright © Acronis, Inc., 2000-2007. All rights reserved. 

Windows and MS-DOS are registered trademarks of Microsoft Corporation. 

All other trademarks and copyrights referred to are the property of their 
respective owners. 

Distribution of substantively modified versions of this document is prohibited 
without the explicit permission of the copyright holder. 

Distribution of this work or derivative work in any standard (paper) book form 
for commercial purposes is prohibited unless prior permission is obtained from 
the copyright holder. 

DOCUMENTATION IS PROVIDED «AS IS» AND ALL EXPRESS OR IMPLIED 
CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY 
IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE 
EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. 
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END-USER LICENSE AGREEMENT 

BY ACCEPTING, YOU (ORIGINAL PURCHASER) INDICATE YOUR ACCEPTANCE 
OF THESE TERMS. IF YOU DO NOT WISH TO ACCEPT THE PRODUCT UNDER 
THESE TERMS, YOU MAY CHOOSE NOT TO ACCEPT BY SELECTING "I 
decline..." AND NOT INSTALLING THE SOFTWARE. 

Acronis® Snap Deploy (the software) is protected by Copyright © Acronis, 
Inc., 2000-2007. All rights are reserved. The original purchaser is granted a 
license to use the software only, subject to the following restrictions and 
limitations. 

The license is to the original purchaser only, and is not transferable without 
prior written permission from Acronis. 

The original purchaser can use the software on a single computer owned or 
leased by the original purchaser. You may not use the software on more than 
a single machine, even if you own or lease all of them, without the written 
consent of Acronis. 

The original purchaser cannot engage in, nor permit third parties to engage 
in, any of the following: 

Providing or permitting use of or disclosing the software to third parties. 

Providing use of the software in a computer service business, network, 
timesharing or multiple-user arrangement to users who are not individually 
licensed by Acronis. 

Making alterations to or copies of any kind of the software (except as 
specifically permitted above). 

Attempting to un-assemble, de-compile or reverse engineer the software in 
any way. 

Granting sublicenses, leases or other rights to the software to others. 

Making copies, or verbal or media translations, of the user’s guide. 

Making telecommunication data transmission of the software. 

Acronis has the right to terminate this license if there is a violation of its terms 
or default by the original purchaser. Upon termination for any reason, all 
copies of the software must be immediately returned to Acronis, and the 
original purchaser shall be liable to Acronis for any and all damages suffered 
as a result of the violation or default. 

ENTIRE RISK 

The entire risk as to the quality and performance of the software is with you 
the purchaser. Acronis does not warrant that the software or its functions will 
meet your requirements or that the operation of the software will be 
uninterrupted or error-free or that any defects will be corrected.  

NO LIABILITY FOR CONSEQUENTIAL DAMAGES 

In no event shall Acronis or its vendors be liable for any damages whatsoever 
(including, without limitation, damages for the loss of business information, or 
any other pecuniary loss) arising out of the use or inability to use the 
software, even if Acronis has been advised of the possibility of such damages.
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Chapter 1. General information 
Acronis® Snap Deploy® is a comprehensive solution designed for simultaneous 
remote deployment of a fully configured operating system with application 
software to target PCs over a network from a previously created image file. 

Acronis Snap Deploy also provides configuration management tools to 
configure system settings, manage files, and execute applications on systems 
throughout the network. 

During deployment, the deploy server multicasts an image of the master PC 
to networked target computers. 

The master image contains everything the system needs to run — the 
operating system and application software.  

Usually, company departments, such as accounting, sales or technical support, 
use a set of applications for daily work. With Acronis Snap Deploy, you can 
create images of commonly used applications and use these images as a 
standard to deploy to target PCs. Because the product uses disk-imaging 
technology that creates an image of an entire hard disk drive, it is ideal for 
rapid bare-metal installations and disaster recovery operations. 

Save money 

Businesses today face increasing challenges when it comes to configuring and 
deploying new PCs in a distributed enterprise environment. IT staffs are 
constantly looking for new solutions that can quickly and efficiently deploy 
new systems that comply with established corporate policies. They also want 
the systems to be managed from a central location. Having a deployment 
solution in place that enables businesses to create and deploy multiple, 
standardized configurations quickly and efficiently can save money. 

Fastest simultaneous deployment 

OS installation and configuration, even on a single PC, is a slow and tedious 
process, but it’s nothing compared to doing it on dozens of brand new PCs. 
Acronis Snap Deploy reduces maintenance costs by providing fast, 
simultaneous deployment of new systems. 

Deploy a live system on different hardware 

You can configure the source system in a virtual environment or on a 
computer with motherboard or CPU differing from that of the target 
computers. The Acronis Universal Deploy option will replace the hardware 
abstraction layer (HAL) and mass storage device drivers so that the deployed 
system is able to boot. With this option, a multiprocessor system can be 
deployed on single-processor hardware and vice versa. 

1.1. Key features 
 Remote simultaneous deployment of master image to target PCs, 

including: 

 Setting the target computers names and domain or workgroup 
membership 



 General information 

 

Copyright © Acronis, Inc., 2000-2007 7

 

 Adding, editing or deleting local user accounts 

 Setting network settings 

 Generation of new security identifiers (SIDs) for the target computers  

 Transferring files to all target computers after deployment 

 Executing applications on all target computers after deployment 

 Running configuration files on all target computers after deployment 

 Managing deployment templates 

 Master image creation 

 Master images checking 

 Support for various ways of boot up (bootable media, Microsoft Remote 
Installation Services (RIS) or PXE servers) 

 Remote PXE Server management 

 File management on a remote PC 

 Application execution on a remote PC 

 Installing Acronis components to a remote computer (requires appropriate 
access rights) 

 Logs viewing 

 Support a variety of IDE, SCSI, USB and PC Card (formerly PCMCIA) 
storage media 

 Support for all hard disks, regardless of capacity 

 Support for backup images created with Acronis True Image 

 User-friendly Windows XP-like interface with full mouse support 

 Comprehensive wizards simplify even the most complex operations 

1.2. New in Acronis Snap Deploy 2.0 
 Acronis Universal Deploy option - Automatic selection of the HAL and mass 

storage device drivers to fit the target hardware 

 64 bit Windows support 

 A facility of master and target computers boot with Microsoft RIS server 

 New Bootable Media Builder 

 New master image creation options (setting the priority of the imaging 
process, validating the newly created image etc.) 

 New deployment options (resizing partitions according to the proportion of 
the master and target disk capacities, shutting down the target computers 
after deployment etc.) 

1.3. Acronis Snap Deploy components 
Acronis Snap Deploy includes the following components: 
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Acronis Snap Deploy Management Console is the primary tool for remote 
management of Acronis OS Deploy Server, Acronis PXE Server and 
master/target PCs. 

Acronis OS Deploy Server controls the simultaneous master system 
deployment on target PCs. 

Acronis Snap Deploy Agent – boots up on each of target PCs and performs 
the system deployment  under control of Acronis OS Deploy Server. There are 
three ways to load Acronis Snap Deploy Agent on target computers: directly 
from bootable media, remotely using Microsoft RIS or remotely using Acronis 
PXE Server. 

Acronis PXE Server allows the booting of the Acronis Snap Deploy Agent or 
Acronis Master Image Creator on remote PCs without using bootable media. 
The remote computers must support PXE. Using Acronis PXE Server 
considerably reduces time required for booting the computers as compared to 
using bootable media. It also eliminates the need to have a technician onsite 
to install the bootable media into the system that must be booted. 

Acronis Snap Deploy Management Agent, if installed on a remote PC, 
allows you to manage that PC using the Acronis Snap Deploy Management 
Console. Management operations include creating master images, managing 
files and executing applications.  

Acronis Master Image Creator – a bootable component that allows local 
imaging of the master system without installing the Acronis Snap Deploy 
Management Agent on the master computer. There are three ways to load 
Acronis Master Image Creator on a master computer: directly from bootable 
media, remotely using Microsoft RIS, or remotely using Acronis PXE Server. 

Acronis Universal Deploy (optional) – enables hardware-independent 
operating system deployment.  

To be able to manage deployment licenses, you must also install the Acronis 
License Server. 

1.4. Acronis Snap Deploy quick start 
To deploy a system on one or more target computers, follow these steps:  

1. Create a master PC configuration, including the operating system, 
applications and settings. 

2. Prepare the master OS with the Microsoft Sysprep tool in case it is needed. 
See details in 5.2 The master OS preparation.  

3. Install the Acronis Snap Deploy Management Console. See details in 
2.6 Acronis Snap Deploy components installation. 

4. Create bootable media with the Acronis Master Image Creator. See 
details in 5.1 Creating bootable media. 

5. Boot Acronis Master Image Creator on the master PC and create a master 
image on a network share. Check the integrity of the master image and 
confirm that it is a valid file and not corrupted. See details in 5.3.2 
Running Acronis Master Image Creator on a local computer. 
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Acronis Snap Deploy supports images created by Acronis True Image. 

6. If you are going to boot target computers from removable media, create 
bootable media with Acronis Snap Deploy Agent. See details in 5.1 
Creating bootable media. 

If you are going to boot target computers with Acronis PXE Server, install 
Acronis PXE Server and upload Acronis Snap Deploy Agent to that 
server. See details in 5.5 Configuring Acronis PXE Server. 

If you are going to boot target computers with Microsoft Remote 
Installation Services (RIS), install RIS server. Then create a RIS package 
with Acronis Snap Deploy Agent. See details in 5.1 Creating bootable 
media. 

7. Install Acronis License Server and upload the appropriate number of 
deployment licenses to it. See details in 4.3 Adding licenses to . 

8. Install Acronis OS Deploy Server. 

9. If you have the Acronis Universal Deploy option, install it on the same 
computer where Acronis OS Deploy Server is installed. See details in 
Acronis Universal Deploy installation section. 

10. Boot Acronis Snap Deploy Agent on the target PCs with the bootable 
media, PXE or RIS server. See details in 6.1 Booting up the target PCs. 

11. Connect the console to the computer where Acronis OS Deploy Server is 
installed and select Manage Deployment in the Acronis Snap Deploy 
Management Console main window. Start the Deploy Image Wizard (see 
6.2 Starting the Deploy Image Wizard). Specify the details of the 
deployment task and target PC settings (TCP/IP settings, 
domain/workgroup settings etc.) in the wizard windows and launch the 
deployment process. See details in 6.3 - 6.16. 

12. Acronis OS Deploy Server begins transferring the master image to the 
target computers. Once the transfer is complete, the target PCs are ready 
to use. No installation of the operating system or applications is required -- 
the image contains everything the system needs to run. 

1.5. Software usage terms and conditions 
The conditions for Acronis Snap Deploy software usage are described in the 
«License agreement», included with this package. The supplied registration 
card is the confirmation of your legal purchase and usage of Acronis Snap 
Deploy on your system. Each registration card has a unique registration 
number. 

Under current legislation, the «License agreement» is considered a contract 
between a user (you) and a software manufacturer (Acronis Inc.). The 
contract is legally binding and its violation may result in litigation. 

Illegal use and/or distribution of this software will be prosecuted. 

 



Installation and operation  

 

10 Copyright © Acronis, Inc., 2000-2007 

 

Chapter 2. Installation and operation 
2.1 System requirements 

For Acronis Snap Deploy components installation: 

 Pentium processor or higher 

 128 MB RAM 

 keyboard 

 mouse (recommended) 

 Floppy disk drive, CD-R/RW drive or another device for bootable media 
creating (USB-device, Zip drive, flash drive etc.)  

 PXE support (recommended) 

For target computers: 

 Pentium processor or higher 

 128 MB RAM 

 keyboard 

 mouse (recommended) 

 Floppy disk drive, CD-ROM drive, any other device to boot from (USB hard 
drive, Zip drive, Flash , etc.) or PXE support 

 DHCP Server (recommended) 

2.2 Supported operating systems 
Acronis OS Deploy Server 
 Windows XP Professional x64 Edition, Windows Server 2003 x64 Editions 
 Windows 2000 Server/2000 Advanced Server/2003 Server 
 Windows Vista all Editions 
 Windows 2000/XP Professional 

Acronis Snap Deploy Management Console 
 Windows XP Professional x64 Edition, Windows Server 2003 x64 Editions 
 Windows 2000 Server/2000 Advanced Server/2003 Server 
 Windows Vista all Editions (except for installation of Acronis components 

on remote machines running Vista) 
 Windows 2000/XP Professional 

Acronis Universal Deploy  
 Windows XP Professional x64 Edition, Windows Server 2003 x64 Editions 
 Windows 2000 Server/2000 Advanced Server/2003 Server 
 Windows Vista all Editions 
 Windows 2000 Professional SP4/XP Professional SP2 

Operating systems for deployment 
 Windows XP Professional x64 Edition, Windows Server 2003 x64 Editions 
 Windows 2000 Server/2000 Advanced Server/2003 Server 
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 Windows Vista all Editions 
 Windows 2000/XP 

Acronis Snap Deploy enables, with certain limitations (some operations or 
options will not be available), deployment of any PC-based operating system. 
For example, Windows 98/NT/ME can be deployed only as is, without 
changing SID, user accounts or network settings. 

2.3 Supported file systems and media 
Acronis Snap Deploy supports the following file systems: 

 FAT16/32 
 NTFS 
 Ext2/Ext3 
 ReiserFS 
 Reiser4 
 Linux SWAP 
 XFS 
 JFS 

Supported media 

Acronis Snap Deploy supports any local, network and removable media, 
including: 

 Local and networked hard drives 
 IDE and SCSI RAID controllers of any level 
 CD-R/RW* 
 DVD+R/RW, DVD-R/RW (DVD burning software required)* 
 USB and FireWire (IEEE-1394) storage devices* 
 Magneto-optical media, Iomega ZIP/Jaz, etc.* 

* When creating a master image on removable media, make sure that the 
image will fit into one disk. The current version of Acronis Snap Deploy does 
not support images, spread on several CDs, DVDs etc. 

2.4 Used Ports and IP addresses 
The Acronis OS Deploy Server and the Acronis Snap Deploy Management 
Console use the following ports and IP addresses for remote operation: 

 UDP port: 9876 

 TCP port: 9876, if busy, choose a port at random 

 IPv4 multicast address: 239.255.219.45 

 IPv6 multicast address: FF05::fAA5:741E. 

 Acronis Snap Deploy Management Console UDP port: 9877, if busy, 
choose a port at random 

The Acronis PXE Server uses following ports and IP addresses: 

 UDP port: 67, 68, 69. 
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 Broadcast address: 255.255.255.255 

 

 

 
 

If you are using a firewall, you might have to set the appropriate access options 

2.5 License policy 
Acronis Snap Deploy licensing is based on number of deployed and/or 
managed computers (servers or workstations). The number of deployments 
onto the same computer, as well as the number of Acronis Snap Deploy 
Management Console, Acronis OS Deploy Server*, Acronis PXE Server or 
Acronis License Server installations is not counted.  

* When installing Acronis OS Deploy Server, you have to specify the Acronis License 
Server. However, no extra license will be engaged. Acronis OS Deploy Server checks 
the availability of free licenses and stores the specified Acronis License Server 
parameters to be able to access the Acronis License Server later, when deployment is 
launched. 

For example, to deploy software on 100 computers you need 100 deployment 
licenses. No additional licenses are required to manage the deployed 
computers or re-deploy any of them. If you want to manage a computer that 
was not previously deployed with Acronis Snap Deploy, you will need a new 
license to install the Acronis Snap Deploy Management Agent to that 
computer. 

Acronis Universal Deploy is an option to Acronis Snap Deploy and has its own 
serial number and license agreement. 

2.6 Acronis Snap Deploy components installation 
You can install all the Acronis Snap Deploy components (Acronis Snap Deploy 
Management Console, Acronis OS Deploy Server, Acronis PXE Server, Acronis 
Snap Deploy Management Agent and Acronis License Server) on one PC or 
each component on a separate networked computer. 

It is recommended that you install Acronis Snap Deploy Management Console 
first. You then will be able to install most of other components remotely to 
any networked computer.  

Before installing Acronis OS Deploy Server, you need to install the Acronis 
License Server and import license numbers to it (see Chapter 4 Using Acronis 
License Server.) 

The installation procedure may differ from the one described below, 
depending on the component. 

To install an Acronis Snap Deploy component: 

1. Run the Acronis Snap Deploy setup procedure. 
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Figure 1. Acronis Snap Deploy Install Menu 

2. In the Install Menu, select the component that you are going to install 
on a PC. Available options are: Acronis Snap Deploy Management Console, 
Acronis OS Deploy Server, Acronis PXE Server, Acronis Snap Deploy 
Management Agent or Acronis License Server. 

3. Read and accept the terms of the license agreement, then click Next. 

4. When installing Acronis OS Deploy Server, specify the License Server for 
license validation. It can be found automatically on the local network or 
can be specified manually. 

5. In the Choose setup type window, choose setup type: 

 Typical -- installs most common program features (recommended for 
most users). 

 Custom -- allows users to choose program features to install and select 
a location for setup (recommended for advanced users). 

 Complete -- all program features will be installed (requires the most 
disk space). 

6. If Custom Setup is chosen, select one of the following for each 
component feature: 

 Will be installed on a local hard drive -- selecting this option 
installs the selected component feature on your computer’s disk drive. 

 Entire feature will be installed on a local hard drive -- selecting 
this option installs the selected component feature, as well as all 
features and subfeatures in the product tree below the selection, on 
your computer’s hard disk. 

 Entire feature will be unavailable – the selected feature will not be 
installed on your computer’s hard disk. 
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Figure 2. Custom setup 

7. In the Select Administrators Options window, choose Install for all 
users or Install for the currently logged-in user, then click Next. 

8. Click Proceed to begin installation. 

Acronis Universal Deploy installation 
Acronis Universal Deploy is an option to Acronis Snap Deploy. It must be 
purchased separately and installed from a separate setup file.  

Acronis Universal Deploy can only be installed on a computer where Acronis 
OS Deploy Server is installed. 

Acronis Universal Deploy can be installed on a networked computer either 
locally, by running the setup program, or remotely. 

To install Acronis Universal Deploy remotely, extract the setup file (.msi) to a 
network share (see below) and install Acronis Universal Deploy in the same 
way as other Acronis Snap Deploy components (see 3.3 Installing Acronis 
components on a remote PC). 

After installation Acronis Universal Deploy automatically plugs in Acronis OS 
Deploy Server. 

2.7 Acronis Snap Deploy components extraction 
During Acronis Snap Deploy Management Console installation, all Acronis Snap 
Deploy applications’ setup (.msi) files will be placed in the C:\Program 
Files\Common Files\Acronis\RemoteInstall folder. You will be able to remotely 
install, modify or repair the components using Acronis Snap Deploy 
Management Console or msiexec.exe utility.  

When installing Acronis Snap Deploy applications on a local computer, you can 
save setup files for each Acronis Snap Deploy component separately on a local 
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or network drive. It will help you modify or recover the existing component 
installation on a local computer. 

1. Run the Acronis Snap Deploy setup procedure. 

2. In the Install Menu, right-click on the application name and select 
Extract. 

3. Select location for the setup file and click Save. 

2.8 Using Acronis Snap Deploy trial version 
If you have not purchased a software license for Acronis Snap Deploy yet, you 
may still try the full-featured trial version of the product. To obtain a serial 
number for the trial version, register on Acronis web site. 

2.9 Running Acronis Snap Deploy 
After installation, Acronis OS Deploy Server and Acronis PXE Server launch 
automatically as Windows services. 

You can run Acronis Snap Deploy Management Console by clicking Start → 
All programs → Acronis → Acronis Snap Deploy Management Console 
→ Acronis Snap Deploy Management Console. 

2.10 Components modification 
You can modify features of the installed components. 

To customize component features, 

1. Run the Acronis Snap Deploy setup procedure. 

2. In the Install Menu, click on the component you are about to customize.  

3. Click Modify in the Modify, Repair or Remove Installation window. 

 
Figure 3. Modify, repair or remove installation 
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4. In the Modify window, choose the component features to be added or 
deleted. 

5. Click Next to apply changes. 

2.11 Repairing components 
During maintenance period, you may need to repair (or restore) Acronis Snap 
Deploy components. 

To repair a component: 

1. Run AcronisSnapDeploy.exe. 

2. In the Install Menu, click on the component you want to repair.  

3. Click Repair in the Modify, Repair or Remove Installation window. 

2.12 Removing components 
You can remove any Acronis Snap Deploy component separately. 

To remove a component from the Control Panel: 

1. Run Control Panel. 

2. Select Add or remove programs. 

3. Click the Remove button on the Acronis Snap Deploy component. 

4. Follow the instructions on the screen. 

You can also remove Acronis Snap Deploy components in the Install Menu. 

To remove a component from the Install Menu: 

1. Run AcronisSnapDeploy.exe. 

2. In the Install Menu, click on the component that is about to be removed. 

3. Click Remove in the Modify, Repair or Remove Installation window. 

2.13 Technical support 
Users of legally purchased copies of Acronis Snap Deploy are entitled to free 
technical support from Acronis. If you experience problems installing or using 
Acronis products that you can’t solve yourself by using this guide, then please 
contact Acronis Technical Support.  

More information about contacting Acronis Technical Support is available at 
the following link: http://www.acronis.com/enterprise/support/. You may also 
register your product on this Web page. Acronis recommends that corporate 
customers purchase Acronis Maintenance and Priority Support. 

 

http://www.acronis.com/enterprise/support/
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Chapter 3. Using the Acronis Snap Deploy 
Management Console 

3.1 Key features 
Acronis Snap Deploy Management Console is the primary administrative tool 
for Acronis OS Deploy Server, Acronis PXE Server and remote computers. In 
addition, it allows you to create and check master images on remote PCs. 

Acronis Snap Deploy Management Console enables you to perform the 
following: 

 Deploy master images to target PCs simultaneously, including: 

o Creating user accounts 

o Managing TCP/IP settings 

o Managing network identification of target PCs (computer name, 
domain or workgroup membership) 

o Transferring files to all target computers after deployment 

o Executing applications on all target computers after deployment 

 Manage Acronis Snap Deploy licenses 

 Manage deployment templates  

 Create master images of remote computers 

 Check master images 

 Create bootable media 

 Configure Acronis PXE Server 

 Manage files on remote PCs 

 Execute applications on remote PCs 
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Figure 4. Acronis Snap Deploy Management Console main window 

3.2 Connecting to a remote computer 
With Acronis Snap Deploy Management Console, you can establish 
connections with remote computers to perform management operations. To 
perform a given operation, you must connect the console to a valid computer. 
For example: 

 To manage a software deployment, connect to a computer with 
Acronis OS Deploy Server installed. 

 

To manage Acronis OS Deploy Server, you must be a member of the 
Administrators or Power Users groups. 

 To configure PXE Server, connect to a computer with Acronis PXE 
Server installed. 

 

To configure Acronis PXE Server, you must be a member of the 
Administrators or Network Configuration Operators groups. 

 To create master images, manage files and execute applications, 
connect to a remote computer with Acronis Snap Deploy 
Management Agent installed. 

Use View → Computers to access the list of machines to which you can 
connect. 

Acronis Snap Deploy Management Console automatically recommends that 
you connect to a remote computer when you select an operation. You must 
connect to the computer running the program you need to perform the 
selected operation or you will get the error message Unsupported protocol. 

To establish connection with a remote PC 
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1. Select New connection in the Remote management sidebar section of 
the Acronis Snap Deploy Management Console main window or the 
associated menu or toolbar items. You can also establish a connection 
using a context menu invoked by right-clicking the desired machine name 
in the View → Computers list. 

2. Specify a PC network name or select a PC by pressing the Browse… 
button. 

3. Enter the user name and password. 

 
Figure 5. Establishing connection with a remote PC 

You can disconnect from a remote PC after accomplishing all necessary 
operations. Click on Disconnect in the Remote Management sidebar. 

3.3 Installing Acronis components on a remote PC 
Acronis Snap Deploy Management Console allows you to install Acronis 
components onto remote computers on a corporate network. For example, 
Acronis Snap Deploy Management Agent installed on a remote computer 
allows you to access to it from the Acronis Snap Deploy Management Console 
for master image creation, managing files and executing applications. 

To install any Acronis component on a remote machine, you will need 
administrator rights on the target system. 

To install Acronis components: 

1. Select Install Acronis components in the Acronis Snap Deploy 
Management Console main window. 

2. Select the installer location from the list (Registered Components, 
Search removable media or Specify location). 

3. Select the Acronis component you want to install. 

4. Specify License Server for license validation. It can be found 
automatically on the local network or can be specified manually. 

5. Specify the network name or IP address of the machine on which the 
Acronis component is to be installed. You can also select a PC from the 
list of available ones using the Browse… button. At that point, you 
will have to provide an administrator user name and password. 
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6. The Acronis component will be installed to the remote PC you 
specified. If you checked the box for Allow to reboot remote 
computer automatically during Acronis components installation, the 
remote machine will reboot. Otherwise, you will see the corresponding 
message. 

 
Figure 6. Remote installation of Acronis components 

 

Installation of Acronis components onto remote machines running all 
Windows Vista editions is not possible. You will have to install the 
components locally on such computers. 

 

If the remote PC runs under Windows XP, make sure the option Use simple 
file sharing in the Control panel → Folder options → View is disabled 
before the remote installation starts. 

 

If the remote PC runs under Windows XP with Service Pack 2 installed, make 
sure that the option File and Printer Sharing in the Control panel →
Windows Firewall → Exceptions is enabled before the remote installation 
starts. 

3.4 Browsing logs 
Using Acronis Snap Deploy Management Console, you can view the server’s 
operations results. To view operation results on the Acronis OS Deploy Server 
or Acronis PXE Server, connect the console to the computer where the server 
is installed. 

Logs can be accessed by selecting Tools -> Show log after connection to a 
remote PC is established. 

The log browsing window contains two panes: the left one features the log 
list, while the right one shows selected log contents. 
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Figure 7. Log viewer 

The left panel can contain up to 50 logs. If there are more, you can browse 
the list using the More and Less buttons with the left and right arrows. The 
buttons appear at the top when the number of log entries exceeds 50. 

To delete a log, select it and click Delete. 

If any step was terminated by an error, the corresponding log will be marked 
with a red circle with a white “X” inside. 

The right window features the list of steps contained in the selected log. The 
three buttons to the right control message filters: the white “X” in the red 
circle filters error messages, the exclamation sign in a yellow triangle filters 
warnings, and the “i” in the blue circle filters information messages. 

To select columns (step parameters) to display, right-click the headers line or 
left-click the Choose Details button. Then check the desired parameters. 

To sort messages by a particular parameter, click its header (click again to 
reverse order) or the Arrange Icons by button (the second from the right) 
and select the desired parameter. 

You can also change column width by dragging the borders with a mouse. 

 

 



Using Acronis License Server  

 

22 Copyright © Acronis, Inc., 2000-2007 

 

Chapter 4. Using Acronis License Server 
4.1 Overview 

The Acronis License Server is a mechanism that tracks individual licenses of 
Acronis products. 

When installing Acronis OS Deploy Server, you have to specify the Acronis 
License Server. You may specify the server’s DNS name, IP address, or let the 
Acronis License Server to be found automatically on the network. Once the 
Acronis License Server is found, the program checks for available licenses on 
the server and stores its net address to be able to access the Acronis License 
Server later, when deployment is launched. 

When performing a deployment, Acronis OS Deploy Server checks the 
availability of free licenses on Acronis License Server. If there are enough free 
licenses for the deployment, the deployment process will run and the number 
of free licenses will decrease by the number of deployed systems. 

Acronis License Server tracks the number of licenses using a MAC address, 
which is unique for each network interface card (NIC). Although a MAC 
address is usually hardwired to the NIC, some operating systems offer a way 
to change it. It is important to note that attempting to change the MAC 
address on a system may impede the Acronis License Server operation and 
prevent you from other deployments to the same computer or from managing 
that computer from the Acronis Snap Deploy Management Console. 

Acronis Snap Deploy licenses cannot be reused. 

4.2 Installation and running 
You must install the Acronis License Server and import product licenses before 
installing Acronis OS Deploy Server. 

4.2.1 Supported operating systems 
Windows XP Professional x64 Edition, Windows Server 2003 x64 Editions 

Windows NT 4.0 Server SP6/2000 Server/2000 Advanced Server/2003 Server 

Windows NT 4.0 Workstation SP6/2000 Professional SP4/XP Professional SP2 

Windows 98/Me 

4.2.2 Typical, Custom and Complete Acronis License Server 
installation 

You can choose Typical, Custom or Complete installation of Acronis 
License Server. The complete installation includes Acronis License Server, 
Acronis License Server Management Console and Acronis License 
Server Management Tool. Typical installation includes Acronis License 
Server and the Acronis License Server Management Console. Custom choice 
allows separate installation of all three components. 
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The Acronis License Server Management Tool is a command-line utility for 
controlling the Acronis License Server, while the Acronis License Server 
Management Console provides an easy-to-use GUI and additional useful 
features such as remote Acronis components installation and license revoke. 
These two programs are intended mostly for Acronis products other than 
Acronis Snap Deploy. You may install only the Acronis License Server and 
manage it via the Acronis Snap Deploy Management Console. 

After installation, Acronis License Server launches automatically as Windows 
service. 

4.3 Adding licenses to Acronis License Server 
You can add serial numbers for any Acronis product to the Acronis License 
Server using the Acronis Snap Deploy Management Console. Trial versions of 
the product will be managed by Acronis License Server; however the serial 
numbers will only be valid for a limited period of time.  

Acronis recommends that you save serial numbers in a text file since the 
Acronis License Server can import multiple serial numbers from a .txt file, 
saving you from time-consuming procedure of typing in each serial number. 
You may create one file with all serial numbers for all Acronis products or 
separate files for each product or purchase. These serial numbers can then be 
imported to the Acronis License Server. 

Once the Acronis License Server has imported the serial numbers, you may 
delete the text file(s) with the serial numbers. When upgraded, recovered or 
reinstalled, the Acronis License Server keeps all the imported serials in its 
memory. It is recommended that you copy the file(s) with serial numbers to 
removable media, or create a hard copy of that file(s) and keep it in a safe 
place. This ensures that you have license data available in case of hardware 
failure. 

Here’s how to add licenses to the Acronis License Server: 

1. Connect to the computer where Acronis License Server is installed. 

2. Select Manage Licenses in the Acronis Snap Deploy Management Console 
main window. The Management Console window will display the following: 
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Figure 8. Viewing all licenses 

3. Invoke Add License Wizard by selecting Add License in the Tasks 
group on the sidebar. 

4. In the Add License window, type in the serial number or a path to the text 
file containing serial numbers. You can also browse folders to find the text file. 

5. In the final window, click Proceed. Acronis License Server performs the 
operation and reports the number of new-added licenses. 

For information on how to import licenses using the Acronis License Server 
Management Tool, see 4.6 Using the Acronis License Server Management 
Tool. 

4.4 Viewing information about licenses  
1. Connect to the computer where Acronis License Server is installed. 

2. Select Manage Licenses in the Acronis Snap Deploy Management Console 
main window. 

There are two modes of viewing data. 

The default mode lists all licenses available on the current Acronis License 
Server. Right-click on the column headings bar to choose details to display: 
Product Name, Serial Number, Import Date, Expiration Date and 
Total number of licenses assigned to each serial number, as well as how 
many of them are Available and Used. For example, if one license 
corresponds to one serial number, Total=1, Available=1, Used=0 (if the 
license is free) or Available=0, Used=1 (if the license is engaged). 

To display more information about used licenses, select Manage Used 
Licenses in the Tasks group on the sidebar. 

The Used mode lists all licenses that are engaged. Right-click on the column 
headings bar to choose details to display: Product Name, Host Name 
(name of the computer using this license), Host Address, Serial Number, 
Acquire Date (when the product using the license was installed) and Renew 
Date. 
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Figure 9. Viewing used licenses 

 

The Revoke License task and the Renew Date parameter are not used in Acronis 
Snap Deploy. For information how to use them with other Acronis products, see the 
dedicated Acronis License Server guide bundled with these products. 

You can sort any list using View -> Arrange Icons by. 

4.5 Removing licenses 
To completely remove a license from the Acronis License Server, select it from 
the default list and click Remove License in the Tasks group on the sidebar.  

4.6 Using the Acronis License Server Management Tool 
The Acronis License Server includes a special command-line utility 
LicenseServerCmdLine.exe that allows you to manage license information. 

During the Acronis License Server installation, LicenseServerCmdLine.exe file 
will be placed in the installation folder, e. g. C:\Program 
Files\Acronis\LicenseServer. 

LicenseServerCmdLine.exe uses the following syntax: 

LicenseServerCmdLine [command] [option1] [option2] 

LicenseServerCmdLine.exe supports the following commands and command 
options: 

--list 

Displays the list of the License Servers available in the local network. 

--status [server name or server IP-address] 

Displays specified License Server status.  

--import [server name] [serial key] 

Adds information about new license (new serial key). You can specify multiple 
serial numbers (space separated).  
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--import-file [server name] [filename] 

Imports license serial keys from .txt or .eml file. 

--help 

Shows usage. 

To import serial numbers to the Acronis License Server: 

1. After the Acronis License Server installation run the 
LicenseServerCmdLine.exe in the Windows Command Prompt (cmd.exe). 

2. If you want to import all serial numbers at once type following command: 

LicenseServerCmdLine --import-file [computername] 
[filename] 

where: 

computername – name of the computer  with Acronis License Server 
installed 

filename – name of the saved file (*.txt or *.eml) with serial numbers 

Example: 

LicenseServerCmdLine --import-file MyServer serials.txt 

3. If you want to import serial numbers manually type the following 
command: 

LicenseServerCmdLine --import [computername] [serial1] 
[serial2] … 

where: 

computername – name of the computer with Acronis License Server 
installed 

serial – license serial number 

For example: 
LicenseServerCmdLine --import MyServer NL6ER-HDVVY-2ZJ27-
RRMMH-AH7Q7 
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Chapter 5. Pre-deployment operations 
5.1 Creating bootable media 

You can boot Acronis Master Image Creator on the master computer or 
Acronis Snap Deploy Agent on the target computers in the following ways: 

1. from removable media (CD-R/RW, DVD-R/RW, diskettes or any other media 
the computers can boot from, such as a Zip drive 

2. using Microsoft Remote Installation Services (RIS) 

3. from Acronis PXE Server. 

Acronis Snap Deploy allows you to create: 

1. bootable media with the Acronis Master Image Creator and/or the Acronis 
Snap Deploy Agent 

2. an ISO image of bootable media on a hard disk 

3. a RIS package containing the same programs.  

For uploading Acronis Master Image Creator or Acronis Snap Deploy Agent on 
Acronis PXE Server, see 5.5 Configuring Acronis PXE Server. 

To create bootable media, a bootable disk ISO image or RIS 
package: 

1. Click Create Bootable Media on the toolbar or the sidebar, select the 
respective task in the center of the console main window, or select Create 
Bootable Media from the Tools menu. You can also run the Bootable 
Media Builder without loading Acronis Snap Deploy by selecting Programs 
-> Acronis -> Acronis Snap Deploy Management Console -> 
Bootable Rescue Media Builder from the Start menu. 

2. Click Next in the wizard welcome window. 

3. Select which components of Acronis Snap Deploy you want to place on the 
bootable media.  
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Figure 10. Selecting components 

The Start automatically after parameter indicates the time interval 
between the computer boot and the selected program’s automatic start. For 
example, if you check the box for Acronis Master Image Creator, the creator 
will launch in 10 (or whatever you select) seconds after the master PC boots. 
This eliminates the need for a click on the boot menu and enables, in the case 
of RIS, fully remote imaging. If you do not check the Start automatically 
after box, the computer will display the boot menu and wait for user’s 
selection. 

4. Select the type of bootable media (CD-R/RW or 3.5” diskettes) you want 
to create. You can create other bootable media, such as removable USB 
flash drives, if the master/target computers’ BIOS has this capability. You 
can also choose to create a bootable disk ISO image or save bootable data 
to a RIS server. 

 

If you create an ISO disk image, you will be able to burn it onto any kind of DVD 
recordable media using DVD recording software. Creating a bootable DVD directly 
from Bootable Media Builder is not possible. 

 

When using 3.5” diskettes, you will be able to write only one component at a time 
(for example, Acronis Snap Deploy Agent) to a diskette (or a set of the diskettes). To 
write another component, start Bootable Media Builder again. 

 
Figure 11. Selecting media 

5. If you are creating a CD, diskettes or any removable media, insert the 
blank disk so the program can determine its capacity. If you chose to 
create a bootable disk ISO image, specify the ISO file name and the folder 
where to place it. If you chose to save bootable data on a RIS server, 
specify the server and provide the user name and password to access it. 

6. Next, if you chose to save the file to removable media, the program will 
calculate how many blank disks are required and give you time to prepare 
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them. You will not see this option if chose to create an ISO image or save 
the file to a RIS server. When you are finished, click Proceed. 

After you create a boot disk, identify it and keep it in a safe place. 

5.2 The master OS preparation 
Before creating a master image for mass OS deployment, it is usually 
recommended to prepare the master operating system with the Microsoft 
Sysprep tool. 

Sysprep is a tool designed for corporate system administrators, OEMs, and 
others who need to deploy operating systems on multiple computers. Sysprep 
assigns a unique security ID (SID) to each target computer the first time the 
computer is started and, if need be, initiates a process that allows replacing 
drivers for plug-and-play devices. 

Acronis Snap Deploy, on its own, can assign to the deployed computers 
unique TCP/IP settings, domain/workgroup settings and SIDs. As a result, you 
have the choice of using the functionality of either Sysprep or Acronis Snap 
Deploy. 

However, if you plan to deploy a system on hardware differing from that of a 
master computer, and have not purchased and installed the Acronis Universal 
Deploy option to Acronis Snap Deploy, you will have to prepare the master 
operating system with the Microsoft Sysprep tool. The following table covers 
cases when you have or do not have to use either of these tools because of 
hardware difference between the master computer and the target computers. 

 Fully identical 
hardware 

Different plug-and-
play devices 

Different hardware 
abstraction layer 
(HAL) and/or mass 
storage controllers 

Without Acronis 
Universal Deploy 

Must use Sysprep Deployment is not 
possible 

With Acronis 
Universal Deploy 

No need to use 
Sysprep or Acronis 
Universal Deploy 

 
Must use Sysprep 
or Acronis 
Universal Deploy 

Must use Acronis 
Universal Deploy 

Note that Acronis Universal Deploy is not a system preparation tool. You can 
apply it to any image when configuring the deployment operation. 

You can download Sysprep from www.microsoft.com or extract it from 
deploy.cab located on Windows NT/2000/XP/Server 2003 installation CD. 

 

We strongly recommend that you read articles about Sysprep and disk duplication in 
the Microsoft Knowledge Base. 

 

http://www.microsoft.com/
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5.3 Creating master image 

5.3.1 Local vs. remote operation 
Acronis Snap Deploy allows you to create master image either locally on the 
master computer (using a bootable version of Acronis Master Image Creator) 
or remotely (using Acronis Snap Deploy Management Console).  

To enable remote imaging, you must install the Acronis Snap Deploy 
Management Agent on the master computer. The Acronis Snap Deploy 
Management Agent then will be included in the master image and deployed 
on all target computers. 

If you want to manage files and execute applications on all target computers 
after deployment, you can use remote master image creation. However, 
normally you do not want excess software in a master image. 

 

We strongly recommend that you use a bootable version of Acronis Master Image 
Creator to create a master image on a local machine instead of master image 
creation on a remote computer. 

 
Acronis Snap Deploy supports images created by Acronis True Image. 

5.3.2 Running Acronis Master Image Creator on a local computer 
1. Boot the master PC from bootable media, PXE or RIS. 

 
Figure 12. Acronis Master Image Creator boot menu 

2. Select Acronis Master Image Creator in the boot menu.  

 

Acronis Master Image Creator can be configured to start automatically after several 
seconds. You can do so when creating bootable media, creating a RIS package, or 
uploading the creator to a PXE server. 

 



  Pre-deployment operations

 

Copyright © Acronis, Inc., 2000-2007 31

3. A dialog box comes up suggesting that you configure Acronis Master 
Image Creator.  

 
Figure 13. Acronis Master Image Creator configure prompt 

If there is no DHCP (Dynamic Host Control Protocol) server in your network, 
the master computer will not be able to connect to the network automatically 
after booting Acronis Master Image Creator. If you want to create a master 
image on a network share, enter the Acronis Master Image Creator 
configuration menu by clicking Yes in a prompt window that comes up at boot 
time. Then enter the master computer’s IP address and other settings 
necessary for connection.  

 
Figure 14. Acronis Master Image Creator configuration: network settings 

 

If Acronis Master Image Creator was configured to start automatically after several 
seconds, the configuration prompt will disappear in a short time. 

4. When Acronis Master Image Creator starts, it displays the Master Image 
Creator welcome window: 
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Figure 15. Master Image Creation Wizard: welcome window 

In this window, click Next and go to step 5.3.4 Selecting disks. 

5.3.3 Running Acronis Master Image Creator on a remote computer 
If you are going to create master image of a remote computer, install Acronis 
Snap Deploy Management Agent on the master computer (see 3.3 
Installing Acronis components on a remote PC) and connect the console to 
that computer. 

1. Select Create master image in the Acronis Snap Deploy Management 
Console main window. 

2. Click Next in the Master image creation wizard welcome window. 

3. Choose image creation mode: Create master image on a remote 
computer and go to step 5.3.4 Selecting disks. 
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Figure 16. Image creation mode 

If you choose Create master image using bootable media, the program 
will suggest that you create the bootable media. If you already created 
bootable media with Acronis Master Image Creator, go to step 5.3.2 Running 
Acronis Master Image Creator on a local computer. Otherwise, create bootable 
media and do the same. For more information about creating bootable media 
see 5.1 Creating bootable media. 

5.3.4 Selecting disks 
In the Imaged Disks Selection window, you will see the hard disk layout of 
the master PC. You can select only the entire disk (disks), not individual 
partitions. Click on the box to select a disk. 
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Figure 17. Selecting disks  

Having selected disks, click Next. Note that this button is disabled if no disks 
are selected. 

5.3.5 Selecting image location 
You can place an image file on any networked PC or on removable media. 
Acronis recommends that you keep master images on the computer with 
Acronis OS Deploy Server installed. It minimizes network traffic during 
deployment. 

You can specify an image location on almost any storage device: 

 Hard disk drive 

 Network drive 

 Removable storage devices (CD-R/RW, DVD+R/RW, DVD-R/RW, Iomega 
Zip, Iomega Jazz, MO, Flash card, etc.) 

 

To create a master image on DVD, you must have third-party DVD-burning software 
installed. 

 

When creating a master image on removable media, make sure that the image will fit 
onto one disk. The current version of Acronis Snap Deploy does not support images 
spanning multiple  CDs, DVDs, etc. 

Select the image location in the disk tree. In the Filename field, enter the 
image filename. If you select a network PC, you have to provide a name and 
password to access the system. 

The program can generate a unique file name. Just click the Generate file 
name for a new file button at the right. 
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Figure 18. Selecting Image location 

 
You can store several disks in a single file, but you cannot append images to a file. 

5.3.6 Setting options 
Set the options for creating master image. 

1. Compression level 

The default setting is Normal. 

Select the data compression level for the image to be created.  

If you select None, the data will be copied without any compression, which 
can significantly increase the image file size. However, if you select 
Maximum compression, the image will take longer to create. 
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Figure 19. Selecting data compression level 

Generally, it is recommended that you use the default Normal compression 
level. You might want to select Maximum compression for removable media 
to reduce the number of blank disks required. 

2. Image creation priority 

The default setting is Low. 

The priority of any process running in a system determines the amount of CPU 
usage and system resources allocated to that process. Decreasing the image 
creation priority will free more resources for other CPU tasks. Increasing of 
image creation priority could speed up the imaging due to taking resources 
from the other running processes. The effect will depend on total CPU usage 
and other factors. 

3. Archive splitting 

Sizeable images can be split into several files that together make the original 
image. 
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Figure 20. Selecting data compression level 

The default setting is Automatic. With this setting, the program will act as 
follows.  

When creating an image on a hard disk: If the selected disk has enough 
space and its file system allows the estimated file size, the program will create 
a single image file.  

If the storage disk has enough space, but its file system does not allow the 
estimated file size, the image will be automatically split into several files. 

 

FAT16 and FAT32 file systems have a 4 GB file size limit. At the same time, the 
existing hard drives capacity may reach as much as 2TB. Therefore, an archive file 
might easily exceed the 4 GB limit if you are going to image the entire disk. 

If you do not have enough space to store the image on your hard disk, the 
program will warn you and wait for your decision as to how you plan to fix the 
problem. You can try to free some additional space and continue or click Back 
and select another disk.  

When creating an image on a diskette, CD-R/RW, DVD-R/RW or 
DVD+R/RW: Acronis Master Image Creator will ask you to insert a new disk 
when the previous one is full. 

You also can select Fixed size and enter the desired file size or select it from 
the drop-down list. The image will then be split into multiple files of the 
specified size. This comes in handy when creating an image that you plan to 
burn to multiple CD-R/RW, DVD-R/RW or DVD+R/RW later on. 

 

Creating images directly on CD-R/RW, DVD-R/RW or DVD+R/RW generally take 
considerably more time than it would on a hard disk. 
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The current version of Acronis Snap Deploy does not support images spanning 
several disks. Therefore, the Fixed Size option is intended for future versions. 

4. Additional settings 

You can choose to check the master image data integrity. Verification will be 
performed immediately after the image is created. 

The default setting is disabled. 

To enable verification, check the Validate the image upon its creation 
completion box. 

5.3.7 Providing comments 
On the wizard page Image Archive Comments, you’ll be able to provide an 
archive file with comments that might include information on the master 
computer and its user, the hard disk, partition data, image creation time and 
any peculiarities and conditions. 

 
Figure 21. Image Archive Comments 

The more details that are provided, the less is the risk of using the wrong 
image during deployment or making some other mistake. 

5.3.8 Image creation summary 
At the final step, the image creation summary is displayed. Up to this point, 
you can click Back to make changes in the created task. 
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Figure 22. Image creation summary 

Clicking Proceed will launch the task execution. The task progress will be 
shown in a special window. You can stop the procedure by clicking Cancel. 

 
Figure 23. Image creation progress 

5.4 Checking master image 
To be assured that your images are not damaged, you can check their 
integrity. To do so: 

1. Connect to a remote computer where Acronis Snap Deploy 
Management Agent is installed or boot the computer where the 
image is stored from Acronis Master Image Creator bootable CD. 
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2. Select Check master image in the Management Console main 
window or a respective task in Acronis Master Image Creator 
menu. 

3. You will see the first wizard window. Click Next to continue. 

4. In the Image Archive selection window, select the image file, using 
Windows Explorer. 

 
Figure 24. Image Archive Selection 

5. Click Proceed to continue. The checking progress will be indicated in 
the new window. 

You can cancel checking by clicking Cancel.  

After the check is complete, you will see the results window. 

5.5 Configuring Acronis PXE Server 
Acronis PXE Server allows you to boot computers with Acronis Snap Deploy 
Agent and Acronis Master Image Creator so you do not have to create 
bootable media. 

 
Network computers must have PXE support to use Acronis PXE Server. 

With Acronis Snap Deploy Management Console, you can configure Acronis 
PXE Server (upload and remove Acronis Snap Deploy Agent and Acronis 
Master Image Creator products). 

Acronis Snap Deploy Agent boots up target PCs to establish connection 
with Acronis OS Deploy Server for the deployment process. 

Acronis Master Image Creator boots up a master PC to create a master 
image from it. 
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To update PXE Server: 

1. Connect to a computer with Acronis PXE Server installed. 

2. Click on Configure Acronis PXE Server in the Acronis Snap Deploy 
Management Console main window. 

3. Click Configure PXE Server in the Tasks sidebar to start the Update 
PXE wizard and click Next. 

4. Check/uncheck components you want to upload/remove and click Next. 

 
Figure 25. Update PXE Server 

The Start automatically after parameter indicates the time interval 
between the remote computer boot and the selected program’s automatic 
start. For example, if you check the box for Acronis Snap Deploy Agent, the 
agent will launch in 10 (or whatever you select) seconds after the target PC 
boots.  This eliminates the need for a click on the boot menu and enables fully 
remote imaging or deployment. If you do not check the Start automatically 
after box, the remote computer will display the boot menu and wait for your 
selection. 

5. In the next window you will see the server configuration summary, 
containing a list of products that will be uploaded/removed. Click Proceed 
to update Acronis PXE Server. 
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Chapter 6. Deployment 
Acronis Snap Deploy Management Console permits you manage simultaneous 
deployments of a master image to target PCs remotely. 

 

Some steps of the deployment procedure may differ from those described below, 
depending on the operating system. 

6.1 Booting up the target PCs 
1. Boot the target PCs from bootable media, PXE or RIS. 

 
Figure 26. Acronis Snap Deploy Agent boot menu 

2. Select Acronis Snap Deploy Agent in the boot menu.  

 

Acronis Snap Deploy Agent can be configured to start automatically after several 
seconds to provide fully unattended deployment. You can configure it when creating 
bootable media, using a RIS package, or uploading the agent to a PXE server. 

3. A dialog box comes up suggesting that you configure Acronis Snap Deploy 
Agent.  

 
Figure 27. Acronis Snap Deploy Agent configure prompt 

If there is no DHCP server in your network, the target computer will not be 
able to connect to the network after booting Acronis Snap Deploy Agent 
automatically. To enable a connection, enter the Acronis Snap Deploy Agent 
configuration menu by clicking Yes in a prompt window that comes up at boot 
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time. Then enter the target computer IP address and other settings necessary 
for connection.  

 
Figure 28. Acronis Snap Deploy Agent configuration: network settings 

You can also specify the DNS name or IP address of the OS deployment 
server; if you do not specify that information, the server will be found 
automatically. If there are several deployment servers on the network, you 
must specify the deployment server that is connected to the console or that 
you are going to connect. 

 
Figure 29. Acronis Snap Deploy Agent configuration: selecting deployment 

server 

 

If Acronis Snap Deploy Agent was configured to start automatically after several 
seconds, the configuration prompt will turn off quickly. 
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4. When Acronis Snap Deploy Agent starts and the target computer is ready 
for deployment, the target computer displays: 

 
Figure 30. Acronis Snap Deploy Agent: ready for deployment 

The progress bar is suspended because the computer is waiting for 
deployment. 

6.2 Starting the Deploy Image Wizard 
1. Connect to the computer with Acronis OS Deploy Server installed. 

2. Click on Manage deployment icon in the Acronis Snap Deploy 
Management Console main window. The Management Console window will 
appear like the graphic below.  

 
Figure 31. Deployment tab 
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In the central part of the window you see the IP addresses of target PCs. 

3. Click Deploy on target PCs in the Tasks group of the sidebar to launch 
the Deploy Image wizard, then click Next in the wizard welcome 
window. 

6.3 Selecting target computers 
Now tick off the IP addresses of target PCs. You can select all target 
computers by checking All clients. Then, click Next. 

 
Figure 32. Target computers selection window 

6.4 Selecting template mode 
Template includes all deployment options (master image to deploy, user 
accounts, network settings etc.). Once you have created a deployment 
template, you can use it in the future and skip all the steps of the deployment 
procedure. 

You can create a new deployment template or use the existing one.  

You can manage templates (create and save new templates, edit or delete 
existing ones) without launching the deployment procedure. For more 
information on this, see 6.17 of this guide. 

The first time you use this function, you must select Create new template. 
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Figure 33. Template Selection 

If you already have templates and want to use one of them: 

1. Choose Select the existing template and click Next.  

2. Then select a template in the Choose Template window and click Next. 

 
Figure 34. Choose template window 

You can modify all settings of the existing template by checking Modify 
existing template. 

3. Acronis Snap Deploy will ask you to change computer name (and IP 
addresses if they were set manually) for target computers. For additional 
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information on computer name and IP settings, see 6.7 and 6.8 of this 
guide. 

6.5 Selecting a master image to deploy 
Select the master image you want to deploy, then click Next. 

 
Figure 35. Image selection 

6.6 Adding user information 
You can create user accounts on target computers and add them to one of the 
following groups: Administrators, Power Users and Users. 

To add user account: 

1. Press on Add button. 

2. Type a user name. 

3. Select the group that the user will be a member of. 

4. Type a password, then confirm it and press OK. 

 

If you have selected the Users group, at the first Windows logon the user will be 
prompted to change the password. 
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Figure 36. User information 

To edit the selected account, click Edit and change the user name, group or 
password. 

To delete the selected account, click the Delete button. 

6.7 Computer name 
At this step, you can specify name and membership of target computers. 
Windows uses that information to identify computers on the network. 

To generate unique names for target computers use wild card 
{start[,count]}, where start – first given numeral value and count 
(optional) - last numeral. For better visual perception, a wild card can be used 
with text combinations for example: Text{start[,count]}. 

Following examples describe the wild card using: 

• {start} – use the current wild card for simple ascending enumeration of 
target PCs from start number to the last PC (N): Computer{0} – 
target computers will have following names: Computer0, 
Computer1, Computer2, ..., ComputerN 

• {start,count} – use the current wild card if you want to enumerate 
group of target computers in ascending order from start number to the 
specified count number: Computer{3,6} – target computers will 
have following names: Computer3, Computer4, Computer5, 
Computer6 

• {start1,count1}{start2,count2} – use the current wild card for 
double-valued target computers enumeration, example: 
Computer{2,3}{5,4} – target computers will have following 
names: Computer25, Computer26, Computer27, Computer28, 
Computer35, Computer36, Computer37, Computer38, Computer45, 
Computer46, Computer47, Computer48 
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start1 (2) – the first figure in a double-valued number (2…)  

count1 (3) – increasing quantity of first figures (2…, 3…, 4…) 

start2 (5)– the second figure in a double-valued number(…5) 

count2 (4)– increasing quantity of second figures (…5, …6, …7, …8) 

Then select the membership of target PCs: 

 Domain -- select this option and type the domain name, if the target 
PCs are to join the domain membership. You must have administrator 
rights to set the domain membership. 

 Workgroup -- select this option and type the workgroup’s name if 
target PCs are to join a workgroup. 

 
Figure 37. Computer name 

Click Next to continue. 

If you have selected the domain membership, later you will be asked for the 
domain administrator’s name and password. 

6.8 Network settings 
You can get Internet Protocol (IP) settings assigned automatically to target 
computers if your network supports this capability and you have a DHCP 
server connected. Otherwise, you will need to set IP properties manually. 

In the Network Settings window, select: 

 Obtain an IP address automatically – IP addresses of target computers will 
be dynamically obtained from a DHCP server. 

 Use the following IP addresses: – set IP addresses manually. Having 
selected this setting, you will have to enter: 

o Start IP address – first IP address in a range of target PCs 
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o Last IP address – last IP address in a range of target PCs 

o Subnet Mask – subnet mask address 

o Default Gateway – IP address of the default gateway 

 Do not change the network settings – select this parameter if you are 
planning to use IP settings from a previously selected master image. If 
you have selected this parameter, skip section 6.9 and proceed to section 
6.10 of this guide. 

 
Figure 38. Network settings 

Click Next to continue. 

6.9 DNS settings 
DNS server properties can be obtained automatically or specified manually: 

 Obtain DNS server address automatically – the address for the DNS 
server will be automatically obtained from the network. 

 Use following DNS server address – specifies that the address for the 
DNS server used by target computers is manually specified. You should 
specify: 

o IP address – address of DNS server 

o Host name – DNS server host name 

o Domain name – DNS domain name  

Click Next to continue. 
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Figure 39. DNS settings 

6.10 Change security identifiers 
You can change security identifiers on target computers.  

The security identifier (SID) is a data structure of variable length that 
identifies user, group and computer accounts. Every account on a network is 
issued a unique SID when the account is created. Internal processes in 
Windows refer to an account's SID rather than its user or group name. 

Check Change Security IDs to make SIDs on target computers unique. 

 
Figure 40. Change security identifiers 
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6.11 Transferring files 
You can select files, which will be transferred to all target computers after 
deployment (for example, installation files).  

To add files for transfer: 

1. Click Add button. Settings window will appear. 

2. In the Source field, click the “…” button to select a file. 

3. In the Destination field, click the “…“ button to specify file location 
on remote computers. 

4. Check Execute file if you want to execute transferred file after 
deployment. 

5. Specify execution parameters in the Parameters field. 

6. Click OK to add file to transfer list. 

 
Figure 41. Transferring files 

To remove a file from the transfer list, select the file and click Remove. 

6.12 Executing applications 
You can specify service applications (from selected master image) for 
executing on all target computers after deployment.  

To execute application: 

1. Click the Add button. Select application window will appear. 

2. In the Application field, click the “…” button to select an application. 

3. Specify executing parameters in the Parameters field. 

4. Click OK to add application to list. 
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Figure 42. Executing applications 

To remove a file from the executing list, select it, then click on Remove 
button. 

6.13 Using Acronis Universal Deploy 
Acronis Universal Deploy is an add-on option to Acronis Snap Deploy, allowing 
deployment of a bootable system on hardware that differs from that of a 
master computer. 

6.13.1 Purpose of Acronis Universal Deploy 
A system image can be deployed easily on hardware identical to that of the 
master computer. However, if the target hardware has a dissimilar 
motherboard, processor or hard disk controller, the deployed system could be 
unbootable. An attempt to transfer the system to a new, much more powerful 
computer will usually produce the same unbootable result because the new 
hardware is incompatible with the most critical drivers included in the image. 

Using the Microsoft System Preparation Tool (Sysprep) does not solve this 
problem because Sysprep permits replacing drivers only for plug-and-play 
devices (sound cards, network adapters, video cards, etc.). The system HAL 
and mass storage device drivers must be identical on the source and the 
target computers (see Microsoft Knowledge Base, articles 302577 and 
216915). 

 

A choice between using Sysprep and Acronis Universal Deploy is covered in 5.2 The 
master OS preparation.  

Acronis Universal Deploy technology provides an efficient solution for 
hardware-independent system deployment by replacing the crucial HAL and 
mass storage device drivers. 
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6.13.2 Acronis Universal Deploy general principles 
1. Automatic HAL and mass storage drivers selection 

Acronis Universal Deploy searches the Windows default driver storage folders 
(in the master image) for HAL and mass storage device drivers and installs 
drivers that better fit the target hardware. You can specify a custom driver 
repository (a folder or folders on a network drive or CD) which will also be 
used for drivers search. 

 

The Windows default driver storage folders are determined in the registry key 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Current version\DevicePath. 
Generally, it is WINDOWS/inf folder.  

2. Manual selection of mass storage device driver 

If the target hardware has a specific mass storage controller (such as a SCSI, 
RAID, or Fibre Channel adapter) for the hard disk, you can install the 
appropriate driver manually, bypassing the automatic driver search-and-install 
procedure. 

3. Installing drivers for plug-and-play devices 

The primary goal of Acronis Universal Deploy is to boot the deployed system. 
The current version of this product handles only HAL and mass storage device 
drivers and does not install drivers for other devices (sound cards, network 
adapters, video cards etc.). Once the deployed system starts, Windows takes 
control and initiates the usual first-start process. At this point, you will be able 
to specify drivers for other devices if Windows cannot find them automatically. 

If you plan to deploy a system to multiple computers that are identical to each 
other but differ from the master computer hardware, use Acronis Universal 
Deploy to modify the master system once and then image and deploy it to the 
additional computers. Acronis Universal Deploy will save you from configuring 
a new master system for each system you will deploy. 

6.13.3 Deploying a system on a virtual machine 
Using Acronis Snap Deploy with Acronis Universal Deploy you can perform 
physical-to-virtual and virtual-to-physical computer migration in the same way 
as with real systems.  

If the virtual hard drive uses a SCSI controller, you should provide the 
appropriate drivers while performing system restore to the virtual machine. 
For example, the widespread VMware environment requires Buslogic or LSI 
logic drivers. Acronis recommends that you use drivers bundled with your 
virtual machine software or download the latest drivers versions from the 
software manufacturer website. 

6.13.4 How to get Acronis Universal Deploy 
Acronis Universal Deploy is an add-on option to Acronis Snap Deploy. It is 
purchased separately and installed from a separate setup file on a computer 
where Acronis OS Deploy Server is installed (see Acronis Universal Deploy 
installation). For more information visit http://www.acronis.com. 

 

http://www.acronis.com/
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The following is for Acronis Snap Deploy installations including Acronis 
Universal Deploy. 

6.13.5 Using Acronis Universal Deploy 
1. Using Acronis Universal Deploy will help you create a bootable system clone 
on dissimilar hardware. Choose this when deploying a system to a computer 
with a different processor, motherboard or mass storage device than in the 
imaged system.  

 

The Acronis Universal Deploy option does not work if master image contains dynamic 
disks and volumes.  

 
Figure 43. Select whether to use Acronis Universal Deploy 

2. Click Next. 

3. If the target hardware has a specific mass storage controller (such as a 
SCSI, RAID, or Fibre Channel adapter) for the hard disk, you can install the 
appropriate driver manually, bypassing the automatic driver search-and-install 
procedure. 

Use this option only if the automatic search-and-install procedure was 
unsuccessful. 

4. Click Next. 

5. You can specify a path to the driver repository (a folder or folders on a 
network drive or CD where the program will search for drivers).  
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Figure 44. Adding a driver repository 

Acronis Universal Deploy uses three sources for drivers:  

- the driver repository - a folder or folders on a network drive or CD specified 
at the current step 

- the mass storage device driver specified by the user at the previous step 

- the Windows default driver storage folders (in the master image).  

The program will pick out the most suitable drivers of all available drivers and 
install them into the deployed system. However, the driver defined by the 
user, will have the priority. It will be installed, with appropriate warnings, even 
if the program finds the better driver. 

 

When deploying the system to a virtual machine that uses SCSI hard drive controller, 
be sure to specify SCSI drivers for virtual environment in the Specifying Mass 
Storage Drivers window. Use drivers bundled with your virtual machine software or 
download the latest drivers versions from the software manufacturer website. 

6. Click Next. 

6.14 Deployment options 
Select the options for deployment process. You can use preset options, shown 
in the current window, or make changes. The settings will be applied only to 
the current task. If you want that your settings be saved as default, select 
Tools -> Options from the main program menu and make changes in the 
appearing window. 

6.14.1 Action after deployment 
Choose whether to turn off or restart the target computer after the 
deployment and all associated operations, scheduled in this wizard 
(transferring files, executing applications) are completed. 
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Figure 45. Deployment options: restart 

The default setting is Shutdown. 

6.14.2 Disk utilization 
If the target disk capacity is not equal to that of the master computer’s disk, 
the program can enlarge (or reduce) each partition according to the 
proportion of the master and target disk capacities. Alternatively, if the target 
disk is larger, the program can keep the original partitions’ size and leave the 
remaining disk space unallocated. 

The default setting is Occupy disk space entirely. 

6.14.3 Network utilization 
You can choose the data transfer mode for the deployment. With the 
Multicast transfer mode, Acronis OS Deploy Server sends data to a group of 
recipients simultaneously. Using the Unicast transfer mode, the server sends 
a copy of the data to each recipient (this can significantly reduce the 
deployment speed).  

For example, you have 128 KB/sec bandwidth and want to deploy system on 
10 target computers:  

 with Unicast mode, the server divides 128 KB/sec among 10 
computers, therefore the data transfer speed will be 12.8 KB/sec for 
each target machine 

 with Multicast mode, the server sends one copy of data to a multicast 
address, and each client will receive data at 128 KB/sec speed. 
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Figure 46. Deployment options: network utilization 

Acronis Snap Deploy uses Internet Group Management Protocol (IGMP) for 
the multicasting. Therefore, all the network hardware (routers and/or 
switches) must be IGMP-capable and correctly configured. The specific 
information on configuring any particular router or switch is usually available 
in the documentation, provided with the hardware.  

If there is no IGMP-capable hardware (or you can not configure it correctly) in 
the network, use the Unicast data transfer mode. 

6.15 Providing comments 
On the wizard page Template Comments, you will be able to provide the 
template with a comment that can include any information on the deployment 
procedure. 
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Figure 47. Deployment template comments 

The more details that you include, the lower the risk that you’ll use the 
wrong deployment template. 

6.16 Deployment Summary 
Next you will see the deployment summary. You can save the template you 
have just created by checking Save the template. 

 
Figure 48. Deployment script 

Click Proceed to start the deployment. 
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6.17 Managing templates 
With the Acronis Snap Deploy Management Console, you can manage 
deployment templates (create and save new templates, edit or delete existing 
ones) without launching the deployment process. 

All deployment templates you have saved are stored on the Acronis OS Deploy 
Server, so you have to establish a connection with the OS Deploy Server to 
manage them. 

All existing templates are listed in the Templates tab of the Management 
Console window. 

 
Figure 49. Templates tab 

To create a new template, click Create template in the Tasks sidebar. Then 
follow the steps for the deployment template creation previously described in 
Chapter 6 of this guide. 

To edit an existing template, click Edit template in the Tasks sidebar. Then, 
make changes in the required template steps, previously described in Chapter 
6 of this guide. 

To delete a template, click Delete template in the Tasks sidebar. 
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Chapter 7. Remote management operations 
7.1 File management on a remote PC 

The Acronis Snap Deploy Management Console allows you to manage files and 
folders on a remote PC. You can create and edit text files (for example batch 
files or scripts), copy files/folders to the clipboard, paste them, or rename and 
delete files/folders. 

 

The Acronis Snap Deploy Management Agent must be installed on a remote PC 
to perform file management operations. 

Connect to the remote PC whose files and folders you want to manage. Select 
Manage files from the list of operations. 

In the File browse window, you will see the current partition layout. You can 
manage files/directories with toolbar buttons, or by selecting the appropriate 
operation in the context menu by right-clicking on the item. 

 
Figure 50. File management 

Create new text file 

1. Select the directory where you want to  create the file and click on the 
Create new text document button in the toolbar. 

2. Enter a file name in the New File window and click OK. 

Edit file 

1. Select a file you want to edit and click on the Edit button in the 
toolbar. 

2. The file will be opened with the associated editor. If the file type is not 
associated with any editor, it will be opened with Windows Notepad. 

Create folder 
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1. Select a directory where you want to create a folder and click on the  
Create new folder button. 

2. Enter a file name in the New folder window and click OK. 

Copy file/folder to clipboard 

Select a file/folder you want to copy to the clipboard and click on the 
Copy button. 

You can copy files/folders from the remote PC and paste them to your 
local machine and vice versa. 

Paste file/folder from clipboard 

Select a file/folder to paste from the clipboard and click on the Paste 
button. 

Also you can copy files/folders from your local machine and paste them to 
a remote PC and vice versa. 

Rename file/folder 

1. Select a file/folder you want to rename and click on the Rename 
button. 

2. Enter a new file/folder name and press the OK button. 

Delete file/folder 

1. Select a file/folder you want to delete and click on the Delete button. 

2. Confirm deleting file/folder by pressing the OK button. 

7.2 Executing applications on a remote PC 
Acronis Snap Deploy Management Console allows you to execute service 
applications (for example, configuration files, scripts, etc.) on a remote PC by 
creating scheduled tasks. The scheduled task contains the application to 
execute and periodicity of the execution. 

 

The Acronis Snap Deploy Management Agent must be installed on a remote PC 
to perform applications execution. 

7.2.1 Creating scheduled task 
To create a scheduled task for application execution: 

1. Connect to the remote PC where you want to execute an application. 

2. Select Execute application in the list-of-operations window. 

3. Click on the Create new scheduled task button to launch the Execute 
Applications Scheduler wizard. 

 

Selecting applications 
In the Application selection window, you will see the current partition 
layout. To select an application, click on it. 
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Figure 51. Application selection 

Click Next to continue. 

 

Selecting task start parameters 
After selecting an application, you must set task execution parameters. 

 
Figure 52. Start parameters 

Do not start automatically – a task will not be executed. You can select 
this variant to leave it disabled. 

Daily – a task will be executed daily at the specified time (selected on the 
next step). 

 



Remote management operations  

 

64 Copyright © Acronis, Inc., 2000-2007 

Weekly – a task will be executed weekly or in some weeks at the specified 
time and day (selected on the next step). 

Monthly – a task will be executed monthly at the specified time and day 
(selected on the next step). 

One time only – a task will be executed once at the specified time and day 
(selected on the next step). 

When my computer starts – a task will be executed at OS startup. 

When I log on – a task will be executed when you log into the OS. 

When my computer shuts down – a task will be executed before every 
shutdown or reboot. 

When I log off – a task will be executed when you log off the OS. 

 
Depending on the operating system, some of these options might be disabled. 

 

Setting up daily execution 
If you select daily execution, you will have to specify some additional 
parameters. First, the Start time (hours and minutes). 

In the Perform this task group, select days to execute tasks on: 

• Every day 

• Weekdays 

• Every x days -- once in several days (specify the interval) 

 
Figure 53. Daily parameters 
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Even if the computer is turned off at the time when the task was scheduled to 
run, you can execute the task later. To do this, check the parameter If the 
computer was turned off at the time when the task was scheduled to 
run, the system will perform the task the next time it is restarted. In 
this case, the task will be executed at the next startup. 

 

Setting up weekly execution 
If you select weekly execution, you will have to specify some additional 
parameters. First, the Start time (hours and minutes). 

 
Figure 54. Weekly parameters 

Specify when in the Every x weeks (each week, in a week, etc.). 

Check weekdays you wish to execute the task. 

Even if the computer is turned off at the time when the task was scheduled to 
run, you can execute the task later. To do this, check the parameter If the 
computer was turned off at the time when the task was scheduled to 
run, the system will perform the task the next time it is restarted. 

 

Setting up monthly execution 
If you select monthly execution, you will have to specify some additional 
parameters. First, the Start time (hours and minutes). 

In the Perform this task group, select time to execute tasks on: 

Day –  on the specified date. 

The... – on the specified weekday (e.g. second Tuesday or fourth Friday); 
selected from drop-down lists. 
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Figure 55. Monthly parameters 

Even if the computer is turned off at the time when the task was scheduled to 
run, you can execute the task later. To do this, check the parameter If the 
computer was turned off at the time when the task was scheduled to 
run, the system will perform the task the next time it is restarted. 

 

Setting up one time execution 
If you select one-time execution, you will have to specify some additional 
parameters. 

First, the Start time (hours and minutes). Second, the Start date. 
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Figure 56. One time parameters 

Even if the computer is turned off at the time when the task was scheduled to 
run, you can execute the task later. To do this, check the parameter If the 
computer was turned off at the time when the task was scheduled to 
run, the system will perform the task the next time it is restarted. 

 

Entering user name 
Specify the name of the user who owns the executed task. 

 

 
Figure 57. User information 

In the upper field enter user name. Enter the password in two fields below. 

Task scheduled successfully 
You have finished scheduling a task. The wizard will again remind you of the 
details of the task provided. 

To close the wizard and return to the main window, click Finish. The task 
created will be named New task. You can rename it if you wish. 

7.2.2 Managing scheduled tasks 
If you select a task in the Active Tasks window, the following buttons in the 
toolbar will be enabled: 

 Execute now allows you to execute the selected task immediately. 

 Rename allows you to give selected task a different name. 

 Delete allows you to delete the selected task. 
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Figure 58. Scheduled tasks 
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